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Peter J Faulks 

112 Photoshop Patch Tool


Using the Patch Tool

http://simplephotoshop.com/photoshop_tools/patch_toolf.htm

	The Patch Tool retouches image using sampled pixels or pattern*.
It works as a combination of the Healing Brush 
 INCLUDEPICTURE "http://simplephotoshop.com/photoshop_tools/imgs/healingbrush.gif" \* MERGEFORMATINET 


with the Lasso Tool:
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There are 2 methods to retouch using sampled pixels.
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There are 2 methods to retouch using sampled pixels.

Method 1.

In the Toolbox, select the Patch £ Tool.
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Method 1: 

1. In the Toolbox, select the Patch [image: image3.png]


Tool.

2. Drag in (select) a damaged area with the Patch [image: image4.png]


Tool**(exactly like with 
Lasso Tool
)
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There are 2 methods to retouch using sampled pixels.

Method 1.

1. In the Toolbox, select the Patch £ Tool.

Done





3. On the Options bar, choose the Source mode.

4. Drag the selection (cursor inside the selection) onto a repair-source area (movie).
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There are 2 methods to retouch using sampled pixels.

Method 1.

1. In the Toolbox, select the Patch £ Tool.

Done





Method 2: 

5. [image: image89.jpg]


Drag in a repair-source area with the Patch [image: image8.png]


Tool*.
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There are 2 methods to retouch using sampled pixels.

Method 1.

1. In the Toolbox, select the Patch £ Tool.

Done





6. On the Options bar, choose the Destination mode.
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There are 2 methods to retouch using sampled pixels.

Method 1.

1. In the Toolbox, select the Patch £ Tool.

Done





[image: image11.png]Photoshop Tutorisls: Patch Tool - Mozila Frefox =

Eile Edit View History Bookmarks Tools Help

D C £ (B http://simplephotoshop.com/photoshop_tools/patch_toolf.htm

9 - usepatchtoolphotoshop 2

2| Most Visited |_| Getting Started 3, Latest Headlines

2 Photoshop Tutoril:Patch Tool x| || mydekiop - mycesop - PeterFou | = |

tool

<TOOLS LIST | SEARCH | DOWNLOAD VIDEO-BOOKS | PHOTOSHOP SCRIPTS

Patch Tool

The Patch Tool retouches image using sampled pixels or pattern®.
Ttworks as a combination of the Healing Brush 7 with the Lasso @ Tool

<
)

P sorce @ vestinton | _usapatter [

Kpolsx
SuNRAT

There are 2 methods to retouch using sampled pixels.
Method 1

1. In the Toolbox, select the Patch £ Tool.

Done





7. Drag the selection (cursor inside of selection) onto a damaged area (movie).

To retouch with a pattern, use Method 3:

8. Drag in a damaged area with the Patch [image: image12.png]


Tool*.
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In the Pattern picker, choose a pattern 
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‘There are 2 methods to retouch using sampled pixels.

Method 1:
1. In the Toolbox, select the Patch & Tool.
2. Drag in (select) a damaged area with the Fatch & Tool=*(exactly like with Lasso & Tool)
3. On the Options bar, choose the Source mode.
4

Drag the selection (cursor inside the selection) onto a repair-source area (movie).

Method 2:

5. Drag in a repair-source area with the Patch <7 Tool*.
6. On the Options bar, choose the Destination mode.
7. Drag the selection (cursor inside of selection) onto a damaged area (movie).

To retouch with a pattern, use Method 3:
8. Dragin a damaged area with the Patch <7 Tool*.

9. In the Fattern picker, choose a pattern (movie).
10. Click the Use Fattern button on the Options bar.
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Click the Use Pattern button on the Options bar.
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3. On the Options bar, choose the Source mode.
4

Drag the selection (cursor inside the selection) onto a repair-source area (movie).

Method 2:

5. Drag in a repair-source area with the Patch <7 Tool*.
6. On the Options bar, choose the Destination mode.
7. Drag the selection (cursor inside of selection) onto a damaged area (movie).

To retouch with a pattern, use Method 3:
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Click Use pattern
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‘There are 2 methods to retouch using sampled pixels.

Method 1:
1. In the Toolbox, select the Patch & Tool.
2. Drag in (select) a damaged area with the Fatch & Tool=*(exactly like with Lasso & Tool)
3. On the Options bar, choose the Source mode.
4

Drag the selection (cursor inside the selection) onto a repair-source area (movie).

Method 2:

5. Drag in a repair-source area with the Patch <7 Tool*.
6. On the Options bar, choose the Destination mode.
7. Drag the selection (cursor inside of selection) onto a damaged area (movie).

To retouch with a pattern, use Method 3:
8. Dragin a damaged area with the Patch <7 Tool*.

9. In the Fattern picker, choose a pattern (movie).
10. Click the Use Fattern button on the Options bar.
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http://davidsaffir.wordpress.com/2009/07/06/portrait-retouch-part-one/
The challenge in portrait retouching has two parts: first, make the subject look good, second, leave no digital “footprints”…. and of course get it done without spending a ridiculous amount of time, too!

[image: image16.jpg]



Lady in Red

A very popular wedding photographer I know makes it a rule that he spends no more than 5-15 minutes on an important image – and the quality he produces is top-notch. Of course, he works hard to get it right in the camera, but he’s also practiced at finding ways to edit the image efficiently and effectively.

Here’s a few tips and techniques along these lines. We will focus here first on retouching lines and things like crows’ feet, and then on smaller bumps and texture problems. I’ll make future posts on additional tips and techniques.

I’m going to assume that your image is color-corrected initially as needed, and that you’re ready to begin the retouching process. The article is fairly detailed, but once you have a bit of practice on-screen, you’ll find things go quickly in your work.

1. You can start and finish in Photoshop, or do your basic color edits in a program like Lightroom, and then switch to Photoshop for the retouching phase. Why use Photoshop? In a word, Layers!

2. In my view, the key to success in retouching is to work on a layer. Layers make it far easier to adjust your work on the fly, or go back to an image and retouch or adjust. Think of a layer as a “sandwich” or composite of a duplicate of your image – each layer on top of the other.

3. Here’s an image of two layers created for an image in Photoshop. Menu selection for creating a layer is Layer>New>Layer Via Copy. The keystroke command is command/control-J (Command on the Mac, Control on PC).
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Create A New Layer

Note: You can edit out hair “flyaways” and such at the beginning or end of this process – doesn’t really matter, unless you are going to change the background too. But in many ways this is a separate topic.

4. Next, we are going to work with the patch tool, or spot healing brush, or healing brush on this new layer. In this discussion, we’ll work with the patch tool. If you wish, you can zoom in a bit.

5. Use the patch tool, as illustrated, and encircle the area you want to change. Once the circle is completed, left click and drag the circle to an area nearby – one which is fairly close in tone, color, and texture to the target. You’ll see the target area change when you release the left mouse button.
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Example, Use of the Patch Tool

Examples of areas you want to target are shown in the next image – under the eyes, corners of the mouth, the small line from the edge of the nose to the corner of the mouth, crows-feet, and the like. Focus on the larger imperfections revealed by the camera; we will address the smaller retouch spots in the second half of this article.
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Examples of Target Areas

…and, DON’T worry about making this step perfect, just get each retouch approximately correct and move on – because next you’re going to see a great, quick technique for refining all of your spot retouches.

6. Once you have taken care of all the significant target areas, you’ll see that the patch tool (spot tool, or spot healing brush) areas all look a bit unfinished. It is tempting to go back and try to correct each one – but wait, there’s more!!

Just adjust the opacity of your new, top layer to blend in the retouch spots. You can dial it down to 70% for a highly polished look, or to 50% for let some of the character and personality peek through. I prefer the second choice, because it looks more natural – and whatever your choice, the super-smooth “Photoshop” look is usually reserved for the big magazine covers, anyway!

7. So here’s the result at 50% retouch layer opacity. You’ll see that the changes are noticeable, but not obvious (this model, obviously, doesn’t need a lot of help). Again, adjust to your personal preference, or that of your customer.
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Example At 50% Layer Opacity

8. When you are finished with this step, save your file. I use Photoshop (PSD) format for layered files, so I can tell files that are “work in progress” apart from finished files, which I save in TIFF format.

9. Next, you can flatten the image to simplify your workflow. The easiest way to do this is go Layer>Flatten Image. Then save the image with a new name, and add a revision number to the file name, such as portrait123_Rev_2.psd.

10. Now, we’re going to address the very small imperfections, bumps, and textures to smooth out the skin.

Some people use a blur method, or something similar to do this. I find that in many cases this can be overdone, and flattens out skin texture and looks unnatural.

11. Create another new layer, as described earlier.

12. Use the Spot Healing Brush. (by the way, I recommend a pen tablet, such as the Wacom device, or a track ball for this. Working with a normal mouse is a bit like drawing with a brick.)

Now, find a target area and zoom into 200-400%. This is a large amount of zoom; any time you want to adjust the area you are viewing or working on, press the space bar and hold – you’ll temporarily see the hand tool – left click and drag to move the target area up/down, left right, and release the mouse button.

Also, I’ve made an outline around a target area, just for demo purposes.
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Detailed Skin Retouching, Sample Target Area

Adjust the brush size so it is just slightly larger than the size of the bits you want to smooth out. This will usually be a very small brush.

Working left – to – right, or the opposite, hover over each target spot and left click once. Keep going – go after the most obvious places, and a few of the secondary ones, but there’s no need to cover every tiny thing. Remember, you’re at super-zoom anyway.

(and… here’s a cool tip to help you perform this step quickly, and make sure you hit all the areas needed:

Go Command/Control-R, or View>Rulers. Go up to the Ruler, hover over it with the mouse pointer, and left click and drag down – you’ll see a line follow your cursor. This is a guideline – keep holding the mouse button down, and drag it down. Make several of these – they are the tracks you’ll use to continue your work.

Note: any time you want to hide the guidelines, press Command/Control-H. To reveal again, repeat the keystroke command.)
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Zoom into 400%, Make Guidelines. Brush is red.

Go along, left-click-click-click. If you see one that looks a bit funny, this almost always due to a brush that is too large, or an adjacent area of color that does not match. Undo, adjust the brush size smaller, and repeat. Experimentation and practice are important here, as each person will want to see slightly different results.

13. Work each row until complete. Now, zoom out to one-half the resolution you are working in, and inspect. If you see problem areas, zoom back in and fix them. If not, zoom out to 100% and inspect.

When you first start out with this technique, I suggest that you work for a minute or two, and do the inspection. That way you’ll have a pretty good idea of what your final result will look like – that will save time, of course.

14. Continue section by section until you’re satisfied that you have a good looking client that still has natural-looking skin textures and appearance. Again, you may choose to adjust layer opacity to suit desired appearance.
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Example, results.

There’s more to portrait retouching, of course – making eyes sparkle, increasing lip contours, improving dimensionality, the 3-D look of the face, and more. Look for these in subsequent posts!

Time to use the Patch tool .

I wanted to get rid of the dark puffy areas below the eyes - and the Patch tool does this in a few seconds!

Select the Patch tool and be sure the Source option is checked in the tool options bar. 
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Then select the area you want to fix (left click and drag out the selection).

(You can also use the Lasso tool to drag out the selection if you want - just remember to switch to the Patch tool when you're done...)
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Now drag the selection to an area that has about the same color and texture as the area you want to replace - and just release the mouse button.


The original area below the eye is now automatically replaced!

Deselect the selection and do the same process on the other eye.

Deselect again. If you want to see this in action drag the patch tool over an eyebrow then select one of the eyes (notice you can see what is replacing the area... and you should gain a new eye!

In step 6 you can see what my image looked like at this point.

The wrinkles below the eyes are totally gone and the new "skin" blends perfectly.

BUT - it really looks kind of fake.

To make the retouch look more real we can use the History Brush tool to paint some of the old details below the eyes back on.

And this is why I told you to Create a snapshot in step 2.

Before you go any further be sure to create another snapshot.

(I always take a lot of snapshots while doing photo retouch. Makes it so easy to go back and do things all over again if you're not happy with the outcome...).

Select the History Brush tool .

Then go to the History palette and check the box to the left of your first snapshot like shown below:

(If you accidentally activate the Snapshot 1 state just click the Snapshot 2 state - or just go down in the History window and click on the latest action before you continue).

Select a brush that suits the area you're going to work on. Click here to see what kind of brush settings I used for this area. As you can see I lowered the opacity to 21%. That's because I just wanted to paint some of the details back.

Now use the brush below the eyes and carefully "paint" some of the details back!

You see my result after using the History Brush tool to the left.

Original picture


This is how the picture looked right from the scanner. Before I started using healing brush tool I did and Image - Adjustments - Auto Color to get rid of the magenta color cast on the picture. Then did an Auto Brightness/Contrast and an Auto Levels. That did the trick for this particular picture. To sharpen the picture a little bit I used the Unsharp mask (Filter - Sharpen - Unsharp mask) with these settings. (Note that different pictures need different unsharp mask settings...). Then I added a Hue/Saturation adjustment layer and added just a little more color. The rest of the process editing this picture is described in the steps above.


Final image 

This is how my picture turned out in the end. I continued working on it just using the Healing Brush tool after the last step. Just working on small skin areas at the time to get rid of the irregularities of the skin. Making the skin look really smooth and flawless.

When I finished working on the face I used the Blur tool to smoothen out the details in the background to make it blend with the rest of the image. I'm really happy about the final result though there's still some flaws that could be worked on some more :)

More on the Patch Tool

The Patch tool lets you repair a selected area with pixels from another area or a pattern. 

Like the Healing Brush tool, the Patch tool matches the texture, lighting, and shading of the sampled pixels to the source pixels. You can also use the Patch tool to clone isolated areas of an image.
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When repairing with pixels from the image, select a small area to produce the best result.

      Using the Patch tool to replace pixels

      Using the Patch tool to replace pixels

      Patched image

      Patched image

To repair an area using sampled pixels:

Open Patch date.jpg from Adobe Photoshop data files
   1. Select the Patch tool Patch tool 

   2. Do one of the following:

          * Drag in the image to select the area you want to repair, and select Source in the options bar.

          * Drag in the image to select the area from which you want to sample, and select Destination in the options bar.

This is my repaired Patch date
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      Note: You can also make a selection prior to selecting the Patch tool.

   3. To adjust the selection, do one of the following:

          * Shift-drag in the image to add to the existing selection.

          * Alt-drag (Windows) or Option-drag (Mac OS) in the image to subtract from the existing selection.

          * Alt-Shift-drag (Windows) or Option-Shift-drag (Mac OS) in the image to select an area intersected by the existing selection.

   4. Position the pointer inside the selection, and do one of the following:

          * If Source is selected in the options bar, drag the selection border to the area from which you want to sample. When you release the mouse button, the originally selected area is patched with the sampled pixels.

          * If Destination is selected in the options bar, drag the selection border to the area you want to patch. When you release the mouse button, the newly selected area is patched with the sampled pixels.

To repair an area using a pattern:

   1. Select the Patch tool Patch tool .

   2. Drag in the image to select the area you want to repair.

      Note: You can also make a selection prior to selecting the Patch tool.

   3. To adjust the selection, do one of the following:

          * Shift-drag in the image to add to the existing selection.

          * Alt-drag (Windows) or Option-drag (Mac OS) in the image to subtract from the existing selection.

          * Alt-Shift-drag (Windows) or Option-Shift-drag (Mac OS) in the image to select an area intersected by the existing selection.

   4. Select a pattern from the Pattern pop-up palette in the options bar, and click Use Pattern.
Photoshop Toolbox Reference

This section of the site is a comprehensive Photoshop Toolbox reference. Click on a tool to view its video-manual*.

	Icon
	Tool
	Key
	Purpose
	 
	Icon
	Tool
	Key
	Purpose

	


	Elliptical Marquee
	M
	selecting
	
	


	Single Row Marquee
	-
	selecting

	


	Rectangular Marquee
	M
	selecting
	
	


	Single Column Marquee
	
	selecting

	


	Lasso
	L
	selecting
	
	


	Move
	V
	transforming

	


	Polygonal Lasso
	L
	selecting
	
	


	Magic Wand
	W
	selecting

	


	Magnetic Lasso
	L
	selecting
	
	


	Crop
	C
	transforming

	


	Slice
	K
	web design
	
	


	Slice Select
	K
	web design

	


	Healing Brush
	J
	retouching
	
	


	Patch
	J
	retouching

	


	Brush
	B
	painting
	
	


	Pencil
	B
	painting

	


	Clone Stamp
	S
	painting
	
	


	Pattern Stamp
	S
	painting

	


	History Brush
	Y
	restores to selected history state
	
	


	Art History Brush
	Y
	painting

	


	Airbrush
	J
	painting
	
	


	Eraser
	E
	erasing

	


	Background Eraser
	E
	erasing
	
	


	Magic Eraser
	E
	erasing

	


	Paint Bucket
	G
	painting
	
	


	Gradient
	G
	painting

	


	Blur
	R
	unfocusing
	
	


	Sharpen
	R
	focusing

	


	Smudge
	R
	painting
	
	


	Sponge
	O
	color adjustment

	


	Dodge
	O
	tonal adjustment
	
	


	Burn
	O
	tonal adjustment

	


	Horizontal Type
	T
	typing
	
	


	Vertical Type
	T
	typing

	


	Horizontal Type Mask
	T
	typing
	
	


	Vertical Type Mask
	T
	typing

	


	Direct Selection
	A
	drawing
	
	


	Path Selection
	A
	drawing

	


	Pen
	P
	drawing
	
	


	Freeform Pen
	P
	drawing

	


	Add Anchor Point
	-
	drawing
	
	


	Delete Anchor Point
	-
	drawing

	


	Convert Point
	-
	drawing
	
	


	Rectangle
	U
	drawing

	


	Rounded Rectangle
	U
	drawing
	
	


	Ellipse
	U
	drawing

	


	Polygon
	U
	drawing
	
	


	LIne
	U
	drawing

	


	Custom Shape
	U
	drawing
	
	


	Eyedropper
	I
	choosing color

	


	Color Sampler
	I
	color information
	
	


	Measure
	I
	geometrical measurements 

	


	Notes
	N
	non-printable data
	
	


	Audio Annotation
	N
	non-printable data

	


	Hand
	H
	navigating
	
	


	Zoom
	Z
	image viewing

	


	Color Selecting box
	-
	displays current color
	
	


	Color Replacement
	J
	retouching

	


	Mode Selector
	Q
	selecting
	
	


	Jump to Image Ready
	Shift+
Ctrl+
M
	web design
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